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Important Notice 
We have done the utmost to make certain that the data that appears on the tax forms 
produced by the Club Tax Printer software is correct as based on the data in your cur-
rent Club Accounting files. Nevertheless, we do not warrant the accuracy or complete-
ness of the data on the printed tax forms. All responsibility for accuracy and complete-
ness rests with your investment club and with the person who handles the tax matters 
for your club. 
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The 2014 Club State Tax Printer 
This State Tax Printer program works by reading your Club Accounting data, 
performing certain calculations, and generating your tax forms. The program 
does not alter the data stored in the Club Accounting software. To properly use 
this program, your accounting records must be up-to-date. We recommend run-
ning the year-end wizard and the 2014 Club Federal Tax Printer before prepar-
ing your state tax return. 

System Requirements 
Use of this software requires at least: 
 A compatible Windows operating system (Windows 2000/XP/Vista/7/8). 
 128 MB of RAM minimum (256 MB recommended). 
 30 MB of free hard drive space. 
 Adobe Acrobat 6.0 or higher, available free from www.adobe.com. 
 Club Accounting version 3.2 (CA3) or higher. 
 A current Club Accounting Maintenance contract. 

Installing the Club Tax Printer 

There are two installation options: 

Download the program installer from the Internet: 
 Go to www.iclub.com/taxes/download/. 
 Click on the appropriate tax printer program. 
 The installation program launches automatically (if you select Open).  
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 If you choose not to allow automatic installation, or choose to Save the down-
loaded file to your computer, install the program manually by clicking on the 
2014 Club Tax Printer Setup icon in the location in which it was saved. 

 You do not need to download the installer onto the computer on which 
Club Accounting 3 is installed. You may download it onto any com-
puter and then transfer the installer to the computer on which Club Ac-
counting 3 is installed via a thumb drive or other device, and then in-
stall the Tax Printer. If you have trouble downloading the installer, try 
this approach. 

Install from a CD: 
 Insert the CD into your computer’s CD-ROM drive. The installation 

program should launch automatically. 

Note: If Club Accounting 3 was open while the tax printer was being installed, you 
must close, and re-open Club Accounting 3 in order for the tax printer to show up. 

Special Note for Clubs in MA, NJ, and WI 

Investment club partnerships in Massachusetts that meet one of the following 
criteria must by law file electronically (E-FILE) and cannot use the ICLUBcentral 
Club State Tax Printer to submit a paper return (however, you may use the program 
to generate the input for the return and associated schedules). 
 Have 25 or more partners (as determined by number of Schedule K-1s at the 

federal level or Schedule 3K-1s at the state level) 
 Have more than $50,000 in gross income (sum of interest, dividend, and other 

income) 
 Have more than $100,000 in stock sale proceeds (gross sales proceeds, not tax-

able capital gain).  

New Jersey investment clubs with 10 or more members (as determined by the 
number of Schedule K-1 forms at the Federal level) must file their NJ-1065 over 
the Internet at the NJ state tax website. There are a significant number of calculations 
required to generate the input for the NJ-1065 return and associated schedules. The 
NJ Club State Tax Printer will make these calculations for you and prepare a full 
return which you can then transcribe to the web based forms.  

Partnerships in Wisconsin must file electronically unless a waiver request has been 
approved by the state. A sample waiver form will be generated by the Club State Tax 
Printer which must be submitted according to the instructions. Once approval has 
been received, the club may submit the paper forms generated by the program. 

NEW FOR 2014: Preparation of State Tax Returns for large clubs in California 
are now supported by the ICLUBcentral Club State Tax Printer. 

Prepare the Club Data 
Note: Skip this step if you have already run the 2014 Club Federal Tax Printer. 

Before generating your tax forms, make sure that your accounting data is properly 
prepared. We recommend that you wait until you have all necessary data and have 
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performed a reconciliation of all partnership accounts before completing your taxes. 
Necessary data includes your year-end brokerage and bank statements; all buys, sells, 
dividends, interest, and service charges through December 31, 2014; and Form 1099s 
issued by your financial institutions. It is likely that you will not have this infor-
mation until late in February. Once you have all the necessary data and the club has 
conducted its annual audit, close the books for the year. Launch Club Accounting 3, 
and select Tools > Year-end Tasks from the menu. Follow the instructions to close 
your books. 

Run the Club State Tax Printer 
The Club State Tax Printer is not a separate program. It is part of Club Accounting 3. 
Simply select Taxes from the menu to start preparing your tax forms. 

 

If you have multiple clubs set up in your Club Accounting software, each time the Tax 
Printer is launched you will need to select which club you wish to work with from a list 
of club names. If you would like to use the program to generate tax forms for several 
clubs, you will need to purchase a Tax Printer serial number for each club. See 
www.iclub.com for more information purchasing additional serial numbers.  

Register the Tax Printer 
When starting the tax printer for the first time, you will see the registration window. 
You must register your program via the Internet with your specific Tax Printer serial 
number before it is usable.  Your Tax Printer serial number is proof that you pur-
chased a license to use this program. It is included with your Tax Printer packaging. 
If you purchased the downloadable version of this program, your Tax Printer serial 
number will be provided via email and on your order receipt. 

About Draft and Final Forms 
The Club State Tax Printer is often released before final forms have been released or 
approved by states. When you initially install the program, it may display preliminary 
forms with a “DRAFT” watermark. These draft forms may not be used to file a tax 
return with your state. They are provided so that you may get a head-start on the 
preparation of your forms, diagnose any possible technical problems, and ensure that 
your tax printer and club accounting software are working properly. 

The Club State Tax Printer does have an automatic updater built into the program. 
Each time you start the Club Tax Printer, it will check the Internet to see if any up-
dates are available. (You must be connected to the Internet in order for the auto-up-
dater to work.) When an update is available, the program will download and automat-
ically install the new version. To check the expected release schedule for your state’s 
returns, please check www.iclub.com regularly throughout tax season. 
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Auto-Updating the Program with Final Forms 
When an update to your Club Tax Printer is available, you will be prompted to 
have the program automatically download and install the new program. When 
final forms  are released by the IRS, they will be implemented in the Club Tax 
Printer and delivered to your computer via this auto-updater. 

Note: Users of Windows 7, Windows 8, or Windows Vista may see a Windows 
User Access Control (UAC) message asking “Do you want to allow the follow-
ing program from an unknown publisher to make changes to this computer?” 
Click Yes, and a dialog box will appear. Click OK to continue with the instal-
lation. 

Enter Your Club Information 
Once you have registered, you will see a screen listing the states which are 
included in the 2014 Club State Tax Printer. Choose your state and click OK. 
On the following screens, you will be prompted to enter information about your 
club needed to generate your club’s tax forms. The specific questions and input 
required vary by state. Please refer to the help files within the program for in-
formation that is relevant to your specific state’s tax return forms. If necessary, 
you may use the program to complete the forms for more than one state for a 
single club. 

Generate Your Tax Forms 
You are now ready to print your state tax return. You should generate a com-
plete return, and then, if your state requires a schedule similar to the Federal 
Schedule K-1, extra copies of this schedule for each member. 

Check the appropriate boxes to print the main tax return and any additional 
schedules (as appropriate for your state). 

Create PDF Files. Selecting Finish will launch Adobe Acrobat and generate 
the forms in PDF format. From Adobe Acrobat, you can save or print your tax 
forms. 

Print Your Tax Forms. To print the forms, click on the printer icon or go to 
the File > Print menu item after you’ve created a PDF copy of your club’s tax 
return. 

Save Your Tax Forms. To save your tax forms in PDF format, click on the 
disk icon or go to the File > Save menu item. The files will be saved in Adobe’s 
PDF format. You may read these at any time using the Adobe Acrobat Reader. 

Additional Notes. A “Partner’s identifying number” for each member may be 
required for the club’s tax return to be complete. If the message No Tax ID 
Entered shows up next to a member’s name, or that box is empty, that member’s 
Social Security Number was not entered in Club Accounting. Add it by hand 
after you have printed the appropriate tax form. 

Select Quit to exit the Tax Printer. 
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Send to Your State Tax Agency 
2014 Club State Tax Printer software prints returns and schedules required for 
filing your club’s tax return in a format acceptable to your state’s Tax Depart-
ment. Instructions for what to send and where to send your return can be found 
on the cover sheet printed with the return. 

Give to Your Members 
If your state requires, give each member a copy of his/her state equivalent to 
Federal Schedule K-1. This schedule will be used in filing their personal state 
tax returns. 

Individuals who withdrew from the club during the year must also be provided 
with the appropriate forms. 

Keep for Club Records 
The club should keep a copy of the full state return, all attached schedules, and 
any additional supporting statements and attachments as part of its permanent 
records. We recommend keeping the electronic PDF files in addition to paper 
copies. 

Common Problems and Release Notes 
 The Club State Tax Printer requires registration before the program can 

be run. Registration is done over the Internet from the registration screen. 
 If you find the program taking a long time to load and/or print your 

Adobe Acrobat Reader and tax forms, your computer or printer may lack 
sufficient memory. Select fewer forms to print, then repeat the process. 

 Links to forms and instructions are found in the program’s help section. 
 The 2014 Club State Tax Printer software uses Adobe Acrobat to gener-

ate your tax forms. A free copy of Adobe Acrobat Reader installs with 
the tax program, and can also be downloaded from www.adobe.com. 

Answers to Frequently Asked Questions 
For more information about club tax filing, using the Club Tax Printer, and 
year-end accounting tasks, we suggest that you first use our Frequently Asked 
Questions (FAQ) searchable database available at www.iclub.com/faq/. The 
answers to the most common questions will likely be found here. 

Helpful Web Links 
For additional help, please refer to the following pages on the ICLUB.com web site: 

 Club Tax Printer Product Info www.iclub.com/taxes/ 

 Frequently Asked Questions www.iclub.com/faq/ 

 Club Tax Principles www.iclub.com/support/general_tax_principles.asp 

 Understanding Club Tax Season www.iclub.com/support/tax_season.asp 
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 Download Club Tax Printers www.iclub.com/taxes/download/ 

 Investment Club Learning Center www.iclub.com/clubs/iclub_hub.asp 

 Free Club Webinars www.iclub.com/clubs/webinar_information.asp 

Help from ICLUBcentral 

Technical Support is available on our web site at www.iclub.com/support/. You may ask spe-
cific questions via our web form and review the Frequently Asked Questions section of the web 
site at www.iclub.com/faq/ as well.  

Requesting Technical Support: 

Each year, your club’s members look to you to make sure their taxes are filed 
in time. And each year, from December to March, ICLUBcentral’s call volumes 
triple. We bring in extra help, update the FAQs, and give it our all to answer 
your questions. Your patience time is appreciated. Here’s looking forward to a 
successful tax season! 

If you cannot solve your problem using the Frequently Asked Questions tool at 
www.iclub.com/faq/, the most efficient way to contact an ICLUBcentral Tech-
nical Support Representative is to use our web help forms located at 
www.iclub.com/support/. Our experts will then be able to retrieve and reply to 
your question quickly and efficiently. 

Use the following guide to help our experts quickly answer your questions. 
Write down the precise wording of any error message displayed, including the 
names of any files mentioned in the message. Be familiar with: 

 The version of Windows you are using. 
 The make, model and amount of memory (RAM) on your computer.  
 The make and model printer if you have a question regarding printing. 
 Note your Club Tax Printer serial number and purchase/installation 

date. 

Note: Answers to questions about Club Tax Printer installation are included 
with purchase of the software. Questions about club accounting principles, tax 
issues, and the Club Accounting software are covered by your Maintenance 
Agreement. To receive full coverage, you must renew your Accounting Soft-
ware Maintenance each year. 
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User License and Support Agreement (ULSA)  
Applicable to the 2014 Club Tax Printer. Use of this product is governed by terms of a User License and support Agree-
ment or ULSA. THIS LICENSE AND SUPPORT AGREEMENT (THE “AGREEMENT”) IS A LEGAL CONTRACT 
BETWEEN YOUR INVESTMENT CLUB OR YOU IN YOUR INDIVIDUAL CAPACITY, AS THE CASE MAY BE 
AS INDICATED IN THE PRECEDING PARAGRAPH (COLLECTIVELY, “YOU”) AND ICLUBCENTRAL INC. 
(“ICLUBCENTRAL”). BY CLICKING ON “ACCEPT” WHEN YOU INSTALL THE SOFTWARE, YOU ARE 
AGREEING TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT, INCLUDING WITH-
OUT LIMITATION THE CUSTOMER SUPPORT PROVISIONS SET OUT BELOW. IF YOU DO NOT AGREE TO 
SUCH TERMS AND CONDITIONS, YOU MUST PROMPTLY RETURN THE SOFTWARE ICLUBCENTRAL OR 
ITS SOFTWARE DISTRIBUTOR, IN ORDER TO RECEIVE A FULL REFUND OF THE LICENSE AND CUS-
TOMER SUPPORT FEES THAT YOU HAVE PAID. If You should have any difficulty in obtaining such refund, please 
contact ICLUBcentral at 711 W. 13 Mile Rd., Madison Heights, MI 48071. 

THE ENCLOSED COPY OF THE 2014 CLUB TAX PRINTER, INCLUSIVE OF ALL ADD-ONS AND FUTURE 
RELEASES, (the “SOFTWARE”), AND THE RELATED DOCUMENTATION, INCLUSIVE OF ALL FUTURE RE-
LEASES (the “DOCUMENTATION”), ARE EACH LICENSED TO YOU WITH A NON-EXCLUSIVE AND NON-
TRANSFERABLE RIGHT, EXCEPT AS ALLOWED BELOW UNDER ‘PERMITTED USES’, TO USE ONLY UN-
DER THE FOLLOWING TERMS AND CONDITIONS: 

PERMITTED USES: You MAY: Install the Software on a storage device in Your computer, as set forth in the instruc-
tions contained in the Documentation. Note: The Software has been designed to only allow it to be used for a single 
individual in Your investment club on a single personal computer. 

NON-PERMITTED USES: You MAY NOT: 

 Make any copies of the Software. 
 Make any copies of the Documentation. 
 Disclose, rent, license, sublicense, lease, sell, lend, disseminate or otherwise distribute the Software.  
 Network the Software or otherwise use it on more than one computer or computer terminal at the same time. 
 Use the Software to conduct a service bureau, application service provider (“ASP”) business or similar business for 

the benefit of third parties. 
 Transfer Your rights under this Agreement. 
 Alter, enhance, supplement, create derivative work therefrom, translate, decompile, disassemble, reverse engineer 

or otherwise reduce the Software to human readable form. 
 Remove or obscure the copyright and trademark notice on the label of the storage medium containing the Software 

or in the Documentation. 
TERMINATION/DURATION: This Agreement and Your license to use the Software and the Documentation will au-
tomatically terminate without notice from ICLUBcentral and without any pro rata abatement of the license and customer 
support fees You have paid if You fail to comply with any term or condition of this Agreement or upon your giving written 
notice of termination to ICLUBcentral. 

This Agreement is effective from the day upon which You indicate acceptance of this Agreement. In order to be granted 
license to use this Software, you must register this Software fully and accurately with ICLUBcentral and receive a valid 
confirmation of registration from ICLUBcentral. The license then granted will continue until either You terminate this 
Agreement by giving written notice of termination to ICLUBcentral; or this Agreement is terminated by ICLUBcentral, 
as provided in the immediately preceding paragraph. 

CUSTOMER SUPPORT PROVISIONS: Included in the total fee that You have paid for the Software and the Docu-
mentation is an amount that covers limited customer support services as described in this Agreement (the “Customer 
Support Services”). ICLUBcentral will provide limited Customer Support Services for the length of time described below 
in the section headed ‘Support Termination/Duration’ during the term of this Agreement.   

CUSTOMER SUPPORT OBLIGATIONS OF ICLUBCENTRAL: Provide customer support for the Software only if 
(i) You have performed the online Product Registration as provided by ICLUBcentral in order to register the Software; 
and (ii) Your copy of the Software is identified with a valid serial number, and Registration Code. 

Investigate and identify any problem reported by You to ICLUBcentral that is related to the then current release of the 
Software, and correct or provide within an appropriate time, as determined by ICLUBcentral, either (i) a workaround for 
any programming error in the then current release of the Software which You have identified, provided that the error is 
directly attributable to ICLUBcentral, or (ii) a resolution to the problem which You have identified (collectively the “Code 
Correction Services”). 

RELATED OBLIGATIONS OF END-USER:  

 Use only the then current release of the Software during the term of this Agreement. 
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 In the event of (i) a problem with the Software that results in either a system crash or loop; or (ii) a situation where 
You can reasonably demonstrate that the Software produces an erroneous arithmetic result that is not a function of 
incorrect or improper input data, then You must submit to ICLUBcentral a written report of all input and keystrokes 
to the Software giving rise to the problem. 

SUPPORT TERMINATION/DURATION: Answers to questions about installation of the Club Tax Printer are included 
with your purchase of the software. Questions about club accounting principles, tax issues, and the Club Accounting 
software are covered by your Club Accounting Maintenance Agreement. To receive full Customer Support coverage, you 
must purchase a Club Accounting Maintenance Agreement and renew it annually.   

LIMITED WARRANTY: ICLUBcentral does not have control over the conditions under which You use the Software 
and does not and cannot warrant the performance or results that may be obtained by its use. However, ICLUBcentral 
warrants that the Software will perform substantially in accordance with the Documentation for a period of ninety (90) 
days from the date the product was shipped to You, provided that the Software is used on the computer equipment, oper-
ating system and in the environment for which it was designed and configured. Your sole remedy and ICLUBcentral ‘s 
exclusive liability under the foregoing limited warranty will be the furnishing by ICLUBcentral, within a reasonable period 
of time and without charge, of the Customer Support Services pursuant to the Customer Support Services provisions of 
this Agreement. To bring a claim under this limited warranty, You should contact Support Department at ICLUBcentral, 
711 W. 13 Mile Rd., Madison Heights, MI 48071 to obtain information on warranty performance; You must be given a 
Return Authorization Number by ICLUBcentral before returning the Software to ICLUBcentral. Some jurisdictions do 
not allow the exclusion or limitation of relief, incidental or consequential damages, so the above limitation or exclusion 
may not apply to You. 

Because computer programs are inherently complex, You are advised to always verify Your work and periodically (after 
each use) back up the data You have created with the Software. 

ICLUBcentral does not warrant that any of the Software, the Documentation or Customer Support Services to be provided 
pursuant to this Agreement will meet Your requirements. The only warranty made with respect to the Software is the 
limited warranty set forth in this Agreement. 

EXCEPT AS SO SPECIFICALLY PROVIDED ABOVE IN THE IMMEDIATELY PRECEDING PARAGRAPH, 
THERE ARE NO WARRANTIES, REPRESENTATIONS, OR CONDITIONS MADE BY ICLUBCENTRAL OR ANY 
OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION OR DISTRIBUTION OF THE SOFTWARE, 
THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, EITHER EXPRESS OR IMPLIED, WITH 
RESPECT TO THE SOFTWARE, THE DOCUMENTATION, ANY RELEASES THERETO, OR THE CUSTOMER 
SUPPORT SERVICES INCLUDING THEIR RESPECTIVE QUALITY, PERFORMANCE, MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. Notwithstanding the above, where applicable, 
if You qualify as a “consumer” under the Magnuson-Moss Warranty Act, then You may be entitled to any implied war-
ranties allowed by law for the period of the express warranty as set forth above. Some states do not allow limitations on 
how long an implied warranty lasts, so the above limitation may not apply to You. This warranty gives You specific legal 
rights, and You may also have other rights which vary from state to state. 

LIMITATIONS OF LIABILITY; INDEMNIFICATION: NEITHER ICLUBCENTRAL NOR ANY OTHER PER-
SON INVOLVED IN THE CREATION, PRODUCTION, DISTRIBUTION OR SUPPORT OF THE SOFTWARE, THE 
DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES WILL BE LIABLE TO YOU OR ANY THIRD 
PARTY ARISING OUT OF THIS AGREEMENT AND/OR YOUR USE OF OR INABILITY TO USE THE SOFT-
WARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, REGARDLESS OF THE FORM OF 
THE CLAIM OR ACTION, THAT EXCEEDS THE PORTION OF THE FEE YOU HAVE PAID FOR THE SOFT-
WARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, AS THE CASE MAY BE. 

NEITHER ICLUBCENTRAL NOR ANY OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION, OR 
DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES 
WILL BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, 
EXEMPLARY DAMAGES OR OTHER INDIRECT DAMAGES OR LOSS OF PROFITS, LOSS OF DATA OR LOSS 
OF USE DAMAGES ARISING OUT OF THIS AGREEMENT; AND/OR 

THE MANUFACTURE, SALE, SUPPLYING OR FAILURE OR DELAY IN SUPPLYING OF THE SOFTWARE, THE 
DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES RELATED THERETO, EVEN IF ICLUBCEN-
TRAL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

Some jurisdictions do not allow the exclusion or limitation of special, incidental, consequential, indirect or exemplary 
damages, or the limitation of liability to specified amounts, so the above limitations or exclusions may not apply to You. 

YOU AGREE TO INDEMNIFY AND HOLD ICLUBCENTRAL AND ALL OF THE PERSONS INVOLVED IN THE 
CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION AND THE 
CUSTOMER SUPPORT SERVICES HARMLESS FROM CLAIMS AND DAMAGES OF ANY TYPE WHATSO-
EVER ARISING FROM ANY THIRD PARTY AS A RESULT OF YOUR USE OF THE OUTPUT FROM, AND/OR 
YOUR INABILITY TO USE THE SOFTWARE OR AS A RESULT OF ANY CUSTOMER SUPPORT SERVICES 
PROVIDED OR TO BE PROVIDED UNDER THIS AGREEMENT. 
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GEOGRAPHIC LIMITATION: ICLUBcentral Customer Support Services cannot be provided at the same level to 
customers outside of the continental United States, Hawaii and Alaska. ICLUBcentral’s website is available to customers 
anywhere in the world. Email support will be provided, on a best efforts basis, to foreign customers, but only in English. 
It is understood that the ICLUBcentral products have been developed for the U.S. marketplace. 

U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and Documentation are “commercial computer soft-
ware” or “commercial computer software documentation.” Absent a written agreement to the contrary, the U.S. Govern-
ment’s rights with respect to such Software or Documentation are limited by the terms of this Agreement, pursuant to 
FAR ‘ 12.212(a) and/or DFARS ‘ 227.7202-1(a), as applicable. 

GENERAL PROVISIONS: The Software, the Documentation, and all releases thereto are licensed to You by ICLUB-
central, and are protected by United States copyright laws and by international treaty provisions. Title to the Software and 
the Documentation, and patents, copyrights and all other property rights applicable thereto, shall at all times remain solely 
and exclusively with ICLUBcentral and its licensors, and You shall not take any action inconsistent with such title. There-
fore, except for the permitted right to make one (1) back up copy of the Software, You must treat the Software and the 
Documentation like any other copyrightable material and are precluded by law from making any copies of them. Any 
rights not expressly granted herein are reserved to ICLUBcentral and its licensors. 

The rights and obligations under this Agreement will be governed by, and any arbitration or court action hereunder shall 
apply, the laws of the State of Michigan, excluding its conflicts of law rules, and will not be governed by the United 
Nations Convention of Contracts for the International Sale of Goods, the 1974 Convention on the Limitation Period in the 
International Sale of Goods (the “1974 Convention”) and the Protocol amending the 1974 Convention, done at Vienna 
April 11, 1980, the application of which is expressly excluded.  

Any dispute, controversy or claim arising out of or relating to this Agreement or to a breach hereof, including its interpre-
tation, performance or termination, shall be resolved in the courts of Michigan.  

The parties irrevocably submit to the exclusive jurisdiction of the federal and state courts of Michigan. Notwithstanding 
anything contained in this paragraph to the contrary, ICLUBcentral shall have the right to institute judicial proceedings 
against You or anyone acting by, through or under You, in order to enforce ICLUBcentral’s rights hereunder through 
reformation of contract, specific performance, injunction or similar equitable relief. 

If any term or condition in this Agreement is invalid or unenforceable in any respect under any applicable statute or rule 
of law, then such term or condition is modified to have the most nearly similar permissible economic or other effect in 
order to be valid and enforceable under such applicable statute or rule of law. 

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE TO BE 
BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT THIS AGREEMENT IS THE COM-
PLETE AND EXCLUSIVE STATEMENT OF THE RELATIONSHIP BETWEEN YOU AND ICLUBCENTRAL, AND 
SUPERSEDES ALL PRIOR OR CONTEMPORANEOUS PROPOSALS, ORAL OR WRITTEN, UNDERSTAND-
INGS, REPRESENTATIONS, CONDITIONS, WARRANTIES, AND ALL OTHER COMMUNICATIONS BETWEEN 
YOU AND ICLUBCENTRAL OR BETWEEN YOU ANY OTHER PERSON INVOLVED IN THE CREATION, PRO-
DUCTION OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT 
SERVICES; AND THIS AGREEMENT MAY NOT BE EXPLAINED OR SUPPLEMENTED BY CUSTOM OR US-
AGE OF TRADE OR ANY PRIOR COURSE OF DEALINGS BETWEEN YOU AND ANY OTHER PERSON. 

IF THERE ARE ANY CONCERNS REGARDING THIS AGREEMENT, PLEASE CONTACT: ICLUBCENTRAL, 711 
W. 13 MILE RD., MADISON HEIGHTS, MI 48071. 
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About ICLUBcentral Inc. 

ICLUBcentral Inc. is the global leader in the development of software tools for in-
vestment clubs. We have been making club accounting and tax software since 1989, 
and our products are used by more investment clubs than any other in the world. 

In addition to Club Accounting 3 for Windows and myICLUB.com 
(www.myICLUB.com), ICLUBcentral also produces: 

 Software programs for stock analysis, including Toolkit 6; 
 Newsletters such as the market-beating Investor Advisory Service 

(www.investoradvisoryservice.com); and the SmallCap Informer 
(www.smallcapinformer.com);  

 Online tools including a portfolio manager, MyStockPortfolio.com 
(www.mystockportfolio.com); a stock screener, 
EquityResearchService.com (www.EquityResearchService.com), and a 
complete suite of online tools, data, and community for investors, 
StockCentral.com (www.stockcentral.com).  

For details and special offers for you and your investment club members, please visit 
www.iclub.com. 
 

 


